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1. Introduction 

1.1. Purpose 

This document aims to specify the definition of requirements for BiblioteQ, presenting the 

description of its features, restrictions and precise specification of the software, with all functional 

and nonfunctional requirements of BiblioteQ system. 

The functional requirements describe the functions or the services you would expect the system to 

provide / offer (essential functions of the system). The term function is used in the generic sense of 

operation that can be performed by the system either by commands of the users or by the 

occurrence of either internal or external to the system. The specification of a functional requirement 

must determine what software is expected to do, without worrying about how he does it. 

The non functional requirements are the requirements that aren’t directly related to the essencional 

functions of the system, they are de global qualities of the software, like usability, performance, 

efficiency, costs among others. Usually these requirements are described in an informal way and 

are difficult to validate. 

1.2 Document conventions 

When writing this document it was inherited that all requirements have the same priority.  

First there is presented an overall view about BiblioteQ and then all features and functions are 

analyzed in detail. 

1.3 Intended audience and Reading Suggestions 

This requirement document contains general information about BiblioteQ, main classes and use 

cases, functions, features and special technologies. It describes in detail all that BiblioteQ needs to 

work properly and with safety. 

The rest of the document is divided into chapters for better understanding. 

 In chapter 2 an overall description of BibliteQ is provided. First product perspective is 

presented with product features and main functions. Then follow user classes and 

characteristics, operating environments that BibliteQ supports as well as design and 

implementation constraints. After all that user documentation is presented and will provide 

you with more details about each feature’s technology. 

 In chapter 3 most important features are presented with detailed description. 

 In chapter 4 user and communication interfaces are described.       
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 In chapter 5 requirements about safety and performance are presented. 

This document is intended for:  

Developers: in order to be sure they are developing the right project that fulfills requirements 

provided in this document.  

Testers: in order to have an exact list of the features and functions that have to respond according 

to requirements. 

Users: in order to understand the functionalities of the Software BiblioteQ and be capable of using 

it. 

1.4 Project Scope 

BiblioteQ is an open source library management suite that can help libraries with cataloging, patron 

tracking, and circulation management. With its multi-functionality and cross-platform availability, 

this free application is a potentially useful library tool, particularly for small libraries at organizations 

such as schools, churches, and other nonprofits. BiblioteQ is based on a database file which can 

store an unlimited number of items. 

This software was created by Alexis Megas and has some contributors: 

Project Members: 

 Alexis Megas (admin) 

 DmitriMendeleev  

 J. Cornavin 

 Muhammet Kara 

 Nir Louk 

 SFHelper 

 jabber2 

Biblioteq can be found and downloaded from http://code.google.com/p/biblioteqonline and the 

project’s official website at http://biblioteq.sourceforge.net/ for free.   

1.5 References 

http://biblioteq.sourceforge.net/ 

This is project’s official website where you can find links to all above and also find features available 

for downloading. 

http://biblioteq.sourceforge.net/index.html
http://code.google.com/p/biblioteqonline
http://biblioteq.sourceforge.net/
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https://sourceforge.net/users/textfield 

In this website you can find out more about the project and discuss any questions in the forums. 

You can go back and look at previous releases, code and problems that have been solved. There 

you can also find information about the developers as well as the project’s main characteristics 

such as programming language and algorithms  
 

http://code.google.com/p/biblioteqonline/wiki/RegisteringOnlineUsers 

In this website you can find Online Interface for the BiblioteQ Library Management Software 

 

http://ospenciiin.blogspot.pt/ 

This blog was created by an interested user where is described the main functionalities of the 

BiblioteQ.  

 

http://biblioteq.findmysoft.com/ 

This is one of the many platforms where the BiblioteQ can be downloaded, and you can find here 

some precious information and a video presenting the software. 

 

http://eden.rutgers.edu/~bab253/550infotech/Ex4/ex4_page1.html 

In this website you can find a review of the BiblioteQ and also contribute with your opinion about 

the software. 

 

http://code.google.com/p/biblioteqonline/wiki/RegisteringOnlineUsers 

Online Interface for the BiblioteQ Library Management Software 

 

2. Overall Description of Software 

2.1 Product perspective 

The BiblioteQ software is available for all major operating systems and is compatible with any 

system that supports Qt. BiblioteQ is distributed under a BSD license and is in constant 

development by a dynamic community of developers and users. 

The BiblioteQ has a Desktop Version: 

The desktop version of BiblioteQ requires Qt 4.8.x and YAZ 4.x.PostgreSQL 8.x, PostgreSQL 

9.x, and SQLite 3.x are supported database engines. 

https://sourceforge.net/users/textfield
http://code.google.com/p/biblioteqonline/wiki/RegisteringOnlineUsers
http://ospenciiin.blogspot.pt/
http://biblioteq.findmysoft.com/
http://eden.rutgers.edu/~bab253/550infotech/Ex4/ex4_page1.html
http://code.google.com/p/biblioteqonline/wiki/RegisteringOnlineUsers
http://code.google.com/p/biblioteqonline/
http://sourceforge.net/project/showfiles.php?group_id=129976
http://qt-project.org/downloads
http://www.indexdata.dk/yaz
http://www.postgresql.org/download
http://www.postgresql.org/download
http://www.postgresql.org/download
http://www.sqlite.org/download.html
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And an Online Version (visit http://code.google.com/p/biblioteqonline for the online version of 

BiblioteQ). 

2.2 Product features 

By installing BiblioteQ, you will be able to organize and manage any collection, no matter how large, 

in the most efficient way possible. That's because BiblioteQ is based on a database file, which can 

store an unlimited number of items.  

BiblioteQ features an easy-to-use interface for cataloging books, DVDs, CDs, journals, magazines, 

and video games.  

BiblioteQ makes it possible to assign unique member IDs to patrons and track basic details such as 

contact information and check-out history. Other features include listings of overdue, requested, and 

reserved items; customizable displays; embedded hyperlinks for localized searches of related items; 

print support; exporting to CSV files; searching capabilities, including custom SQL queries; and 

translation support. 

Summary of BiblioteQ's features: 

 Administrator roles. 

 Cataloging of books, dvds, journals, magazines, music cds, photograph collections, and 

video games. 

 Cover images with drag and drop support. 

 Customizable displays. 

 Customizable item data, pricing information, and currencies. 

 Embedded hyperlinks for localized searches of similar items. 

 Exporting of views to CSV files. 

 Free and Open Source technology. 

 Front cover image retrieval via Amazon. 

 Internationalization (translation) support. BiblioteQ currently supports the Czech, Dutch, 

English, French, German, and Greek languages. 

 Item reservation histories for patrons. 

 Item reservation. 

 Listings of overdue items, requested items, and reserved items. 

 Patron information. 

http://code.google.com/p/biblioteqonline
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 PostgreSQL accounts with various privileges. 

 Print support. 

 Rich search capabilities, including custom SQL queries. 

 Support for multiple SRU and Z39.50 sites. 

 Support for requesting unavailable items. 

 Threaded data retrieval via the standard Z39.50 protocol for books, journals, and 

magazines. 

 Transactional database queries. 

 True PostgreSQL and SQLite pagination. 

 Uniform functionality across various platforms. 

2.3 User classes and characteristics 

End users/Desktop: users with no particular knowledge on computer programming. They just use 

the database for organizing their data and to keep them safe. 

System administrators: True administrator privileges are only available on PostgreSQL 

databases.  SQLite databases are fully editable by the owners of the databases. 

You must install PostgreSQL and configure it properly for BiblioteQ in order to utilize BiblioteQ's 

PostgreSQL administrator roles. If you are using the application for recording small sets of data 

and/or are unfamiliar with PostgreSQL, SQLite is recommended.  

You can find more information in this website:  http://code.google.com/p/biblioteqonline/ 

2.4 Operating environment 

The technologies used in the development of BiblioteQ include: RedHat JBOSS AS7, JSF 2.0, 

RichFaces 4.0, Hibernate 4.1, PostgreSQL 9.1, and Lucene 3.6.0.  

BiblioteQ Specifications 

 User Interface: Qt; 

 Programming Language: C++; 

 Database: PostgreSQL, SQLite; 

 Platforms: FreeBSD, Linux, Mac OSX, Solaris, Windows; 

http://code.google.com/p/biblioteqonline/
http://qt.nokia.com/
http://www.cplusplus.com/
http://www.postgresql.org/
http://eden.rutgers.edu/~bab253/550infotech/Ex4/%20http:/www.sqlite.org/
http://en.wikipedia.org/wiki/FreeBSD
http://en.wikipedia.org/wiki/Linux
http://en.wikipedia.org/wiki/Mac_OS_X
http://en.wikipedia.org/wiki/Solaris_(operating_system)
http://en.wikipedia.org/wiki/Microsoft_Windows
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 Current Languages: Czech, Dutch (Belgium), Dutch (Netherlands), English, French, 

German, Greek. 

2.5 User environment 

The program has a nice and organized interface, with intuitive menus, and toolbars that provides 

easy access to key features of data management. 

In the main window of the application you can view all items that already exist in the database: 

books, journals, DVDs and other materials. 

 

 
 

Figure 1: Main window of biblioteQ 

Besides the main information displayed, in this window, through the menus and toolbars, the 

user can: 

1. add, duplicate, delete and modify, the several item(s) 

2. print current view. 

3. reserve the selected item 

4. display members browser. 

5. database search (General search or item search) 

6. custom database query. 

7. refresh table. 

8. Select viewable columns. 
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Figure 2 – Location of the toolbars and drop-down menus 

 

 

 

 
Figure 3 – Toolbars description 

 
 

3. System Features 

The more important features for a library database are: 

o Create New Database and Open an existing Database; 

o User Manager (Administrator roles, …); 

o Cataloging (Cataloging of books, dvds, journals, magazines, music cds, 

photograph collections, and video games; 

o Reservations (Item reservation histories for patrons, Item reservation, Listings of 

overdue items, requested items, and reserved items); 

o Transactional database queries; 

o Customizable item data, pricing information, and currencies. 

3.1. New Database 

The most recent version of the software can be found in the website http://biblioteq.sourceforge.net  

(the software files along with detailed instructions in the ZIP file). 

After the application has been installed and launched, the user first needs to create a new database 

file and then add the desired items into his collection. After you choose New SQLite Database from 

the [File] Menu you need to indicate a name and location to save the file: 

Edit  

  

Connect  

 

 

Exit  

   Search           Reservations 

 

Configurations 

Drop-down menus 
Toolbars 

http://biblioteq.sourceforge.net/
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Figure 4 – Create a New SQlite Database 

If you have already created one SQLite file, simply select in the [File] menu the option Recent 

SQLite files, and choose which file to open, or use connect from the same menu to select a saved 

file. 

3.2. User Manager  

The software allows the inclusion, alteration or removal of members. In the main window press the 

button Display Members Browser ( ) and you can introduce the following attributes in General: 

Member ID, Member Since, First Name, Last Name, Middle Initial, Date of Birth, Fri, Street, City, 

State & Zip Code, Telephone Number, Email Address, Expiration Date, Overdue Fees, and 

Comments; and the following attributes in Site: Class and General Registration Number. 

 

 
Figure 5 – Insert Member Information 

In this form we can also: 

 Search for Members by Id or Last Name  

Add Member 

Delete Selected 

Member 

Modify Selected 

Member 

Display Members Browser 

Member information 



Software Requirements Specification for BiblioteQ       11 

 

Figure 6 – Field for searching by Member ID or Last Name in Members Browser 

 View the reserves history of selected user, and 

show the selection list of members with items 

reserved, with the following attributes: 

Member ID, First Name, Last Name, Member 

Since, Expiration Date, Books Reserved, 

Reserved CDs, DVDs Reserved, Reserved 

Journals, Magazines Reserved, and Video 

Games Reserved. 

 Print selected members with reserved items.  

 List all items whose reservation period has already 

expired. 

 Refresh table of member’s browser.          

 
3.3. Cataloging 

Biblioteq allows Cataloging of books, dvds, journals, magazines, music cds, photograph collections, 

and video games. For each category the user will be able to add several information by fill in a 

specific form for that cathegory, for example to add audio CDs, BiblioteQ will allow users to type the 

name of the artist, genre, year, song names and so on. 

In the main window you can do this in two ways: by selecting the option Add Item on the drop-down 

menu [EDIT] or by clicking the button ( ) of Edit Toolbar. In both ways you must choose the 

category you want to add items (books, cds, dvds, …) and then the appropriate form is open. 

 

   
Figure 8 – Adding an item using the button in the toolbar  Figure 9 – Adding an item using the drop-down menu [Edit] 

  

Show Selected Members 

Reservation History 

List Selected Members 

Reserved items 

Print Selected Members 

Reserved items 

 
Figure 7 – Toolbars available in Member’s 

browser 
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3.3.1. Add a Book 

After you choose Add Book a new form is open, and you can start to introduce the information of 

the book in the appropriate fields: 

 
Figure 10 – Specific Form to insert a new book 

 
Here the user will be able to introduce several information such as: Cover Image, ISBN-10 or ISBN-

13, Edition, Author(s), Book Binding Type (Hardcover, Paperback), LC Control Number, Call 

Number, Dewwy Class Number, Title, Publication Date, Publisher, Place of Publisher, Categories, 

Price, Language, Monetary Units, Copies, Location, Abstract, MARC Tags, Keywords, SRU Query, 

Z39.50 Query, Print and reset any of the fields. Each book can have one or more copies in the 

BiblioteQ. So the system will assign a unique identifier to each copy (Copy Identifier). In the end 

press de Save button, and Close the form. 

3.3.2. Add a DVD 

After you choose Add DVD a new form is open, and you can start to introduce the information of the 

dvd in the appropriate fields. 

 

Figure 11 – Specific Form to insert a new DVD 

Here the user will be able to introduce several information such as: cover images, UPC (Universal 

Product Code), Actor(s), Director(s),Number of Discs, Runtime, Format, Region, Aspect Ratio, 
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Teatle, Ratio, Release Date, Studio, Categories, Price, Language, Monetary Units, Copies, Location, 

Abstract, Keyword, Save, Reset any of the fields, Print and Close de window of the adding a DVD.  

3.3.3. Add a Journal 

After you choose Add Journal a new form is open, and you can start to introduce the information of 

the journal in the appropriate fields: 

 
Figure 12 – Specific Form to insert a new Journal 

Here the user will be able to introduce several information such as: cover images, ISSN, Volume, 

Issue Number, LC Control Number, Call Number, Dewey Class Number, Title, Publication Date, 

Publisher, Place of Publication, Categories, Price, Language, Monetary Units, Copies, Location, 

Abstract, Save, SRU Query, Z39.50 Query, Reset any of the fields, Print and Close de window of the 

adding a Journal.  

3.3.4. Add a Magazine 

After you choose Add Magazine a new form is open, and you can start to introduce the information 

of the Magazine in the appropriate fields: 

 
Figure 13 – Specific Form to insert a new Magazine 
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Here the user will be able to introduce several information such as: cover images, ISSN, Volume, 

Issue Number, LC Control Number, Call Number, Dewey Class Number, Title, Publication Date, 

Publisher, Place of Publication, Categories, Price, Language, Monetary Units, Copies, Location, 

Abstract, Save, SRU Query, Z39.50 Query, Reset any of the fields, Print and Close de window of the 

adding a Magazine.  

3.3.5. Add a Music CD 

After you choose Add Music CD a new form is open, and you can start to introduce the information 

of the Music CD in the appropriate fields: 

 

Figure 14 – Specific Form to insert a new Music CD 

Here the user will be able to introduce several information such as: Cover Images, Catalog Number, 

Format, Artist(s), Number of Discs, Runtime, Audio, Recording Type, Tracks, Title, Release Date, 

Recording Label, Categories, Price, Language, Monetary Units, Copies, Location, Abstract, 

Keywords, Save, Reset any of the fields, Print and Close de window of the adding a Music CD.  

3.3.6. Add a Photograph Collection 

After you choose Add Photograph Collection, a new form is open, and you can start to introduce the 

information of the Create Photograph Collection in the appropriate fields: 
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Figure 15 – Specific Form to insert a new Photograph Collection 

Here the user will be able to introduce several information such as: Select (Images), ID, Title, 

Location (insert information of location), insert information of the item and ID, Title,Creator(s), 

Publication Date, Copies, Medium, Reproduction Number, Copyright, , Save, Add Item, Reset any of 

the fields, Export Photographs Print and Close de window of the adding a Photograph Collection.  

3.3.7. Add a Video Game 

After you choose Add Video Game a new form is open, and you can start to introduce the 

information of the Video Game in the appropriate fields: 

 

 

Figure 16 – Specific Form to insert a new Video Game 

Here the user will be able to introduce several information such as: Cover Images, UPC (Universal 

Product Code), Game Rating, Developer(s), Title, Release Date, Publisher, Place of Publication, 

Genres, Price, Language, Monetary Units, Copies, Location, Abstract, Save, Reset any of the fields, 

Print and Close de window of the adding a Video Game.  
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3.3.8. Modify, delete and duplicate existing Items 

Every existing item in the library can be modified at any time. After selecting the item, use the 

option Modify Selected Item(s) from [Edit] menu or make a double-click in the selected item: 

  

Figure 17 – How to Modify Selected Item(s) 

The information will be presented and the fields will be enabled to make all the necessary changes. 

Besides modifying the item, you can delete and duplicate the selected item using the [Edit] Toolbar 

where you can find buttons to these functionalities: 

 
 
Figure 18 – Description of Edit Toolbar  

 
 
 

 
 

3.4. Reservations  

 
To reserve (book) one of the existing items in BibliteQ there are two options that can be selected in 

the main window: 

1) In the combo box you select, for instance, Books.  

The list beside that was previously showing all the items of the database now display only 

the books. 

2) Select one book from the list.  

Add Item 

Duplicate selected Item(s) 

Delete selected Item(s) 

Modify selected Item(s) 

View Selected Item(s) 

Print Current View 
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3) Now you can do the reservation by pressing one of the buttons Display Members Browser   

( ) or Reserve Selected Item ( ).  

 

 

 

 

 

 

 

 

Figure 19 – Steps to make a reservation 

4) The list of existing members is shown and you select the member that will reserve the item. 

5) Here we can reserve the book previously selected in the main menu, pressing the button 

Reserve Selected Item ( ) in the right side toolbar. 

6) A new form is open, and you can select the copy (barcode) of the book that you want to 

reserve and schedule the delivery date. Finally press the button [Reserve] and the selected 

book are reserved. 

 Figure 20 – Scheduling the delivery date in a reservation process 
 
In the reserve Window the system allow you to: Filter Member ID or Last Name; Add Member ; 

Delete Selected Member ; Modify Selected Member ; Show Selected Member’s Reservation 

History ; List Selected Member’s Reserved Items ; Print Selected Member’s Reserved Items 

; Grant Privileges ; List All Overdue Items ; Refresh Table  and Close Browse . 

To change the delivery date of one item or to register his devolution, of a book previously reserved, 

we should proceed this way:  
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1) First, in the main window, in the drop down menu select Books and select the return book 

in the list, by doing double-click. A new form is open: 

 
Figure 21 – Consulting the Reservation Status of one Item 

 
2) In this window you will found a button Reservation Status that you should pressed to see all 

the information about the reservations of this particular item: 

 
Figure 22 – Information of item reservations 

3) Here you can change the delivery date and save the changes, or register the book 

devolution by pressing the button Return.  

Modify Selected Item 

Case an item from the collection was borrowed to a specific person, the user can add full details 

regarding that person. Furthermore, one can print the list of items from his collection for future 

analysis and can also save it as a regular CSV file, which can be imported in any compatible 

application.  

3.5. Database queries. 

One of the most important features in a library database is the capability of search. For items with 

ISBN and ISSN numbers, BiblioteQ offers the ability to query the Library of Congress and Columbia 

University catalogs via the standard Z39.50 protocol, thereby allowing for quicker data entry. 
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Figure 23 – Query the Library of Congress and Columbia University catalogs via the standard Z39.50 protocol 

 

For the general search, in the main window there is one button in the tool bar with this purpose (

) and by the [Tools] menu, selecting the Database search option or by the shortcut keys Ctrl+F: 

 

Figure 24 –Search Options 

Selecting one of the several options of research (general search, book search, ...),  the user obtains 

a different form to fill with the requisites for his search: 

 

Figure 25 – General search form    Figure 26 – Book search form 

For custom search, the BiblioteQ allows users to create his own query, by introducing his own SQL 

code. After pressing the button ( ) in the Search Toolbar the user obtain a window with the tables 

and fields available in the database to use in the query, and a text field to introduce de SQL code: 
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Figure 27 – Custom Query Window  

 

3.6. Customizable item data  

 Database Enumerations Browser 

From the main window, press the Database Enumeration button ( ), and the following window 

appears in which you can configure the possible options for certain attributes available in the 

database: 

 
Figure 28 – Database Enumeration Browser  

Here you can add  attributes to each property, delete selected attributes , save changes , 

refresh data  and close the window . 

Tables and fields 

available in the 

database 

Section to type de SQL 

code 
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 Database Options 

Biblioteq allows you to customize some other things: 

 
Figure 29 – Options Menu  

 

Such as: 

 Automatically Save Settings on Exit; 

This feature only saves the settings under the Options menu, or by the Shortcut key Ctrl+S. 

If you want options to be retained automatically, the Automatically Save Settings on Exit will do 

that. If the setting is not enabled, options are not saved upon an exit. 

 Display Table Grid; 

 Populate Adminstrator Browser Table on Display (only available in online version); 

 Populate Database Enumeration Browser on Display; 

 Populate Members Browser Table on Display; 

 Populate View on Connect; 

 Populate View on item Creation; 

 Preserve Main Window’s Geometry; 

 Reset Error Log on Disconnect; 

 Entries per Page; 

From the Options menu, users can change the number of page entries allowed and also save 

settings. 

 Language; 
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From the Options menu, users can change the language: Czech; Dutsh (Belgium or 

Netherlands); English; French; German or Greek.   

 Preferred SRU Site; 

From the Options menu, users can change the CUNY Union Catalog or Library of Congress. 

 Preferred Z39.50 Site; 

From the Options menu, users can change the Columbia University or Library of Congress. 

 Save Settings; 

 Selected Global fonts. 

From the Options menu, users can change the Font, Font style, Size, Effects, Sample or Writing 

system for configure the BiblioteQ.  

4. External Interface Requirements 

4.1. User interfaces 

User interface includes various forms and windows. The main database window consists of the 

main menu bar with File, Edit, View, Tools, Options and Help. Under main menu there is a toolbar 

with shortcuts to most used functions of Biblioteq. Those are:  

 
Edit Toolbar       Search      Reservations          Configurations 

 

Edit Toolbar: View Selected Item (s), Add Item, Duplicate Selected Item (s), Delete Selected Item (s), 

Modify Selected Item (s), Print Current View. 

Search Toolbar: Database Search, Custom Database Query, Refresh Table.  

Reservations Toolbar: View Member’s Reservation History, Item Requests, Reserve Selected Item, 

Display Members Browser.  

Configurations Toolbar: Select Viewable Columns. 

Connect Toolbar: Connect, Disconnect, Change Password, Database Enumerations, 

Configure Administrator Privileges, and Exit Biblioteq, can be found at a side bar.  
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When a function is performed like adding editing or deleting, the active window is the performing 

the action, and the main window. At this time the main database window is active and can be 

accessed. 

 Standard buttons and navigation links  

Figure 30 – Navigation Links  

The combo box that appears in the main window is one of the most important functionality. This 

field allows users to filter the items listed on the items table. Here you can select All Available items, 

or all the items that are currently reserved, or even the overdue reservations. 

The embed hyperlinks are automatically assigned by the program in the main fields and let the user 

search related items: 

  
Figure 31 – Automatic Embed hyperlinks  

 

 

Embed Hyperlinks- 

by clicking this links 

is shown a list of all 

items related 
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Some of the buttons that are most common in the several windows of the BiblioteQ are: 

Print button 

Refresh button 

Change/modify selected Item 

Delete selected Icon 

Database Search 

Reserve Selected Item 

Close current beowser (window) 

Disconnect Database 

Exit BiblioteQ 

 

 Shortcut keys. 

Create a new database Ctrl +N 

Disconect Database Ctrl + D 

Exit BiblioteQ Ctrl + Q 

Delet Selected Item Ctrl +X 

Duplicate Selected Item Ctrl +U 

Modify selected item Ctrl +V 

View Members Browser Ctrl +M 

View Error Log Ctrl +L 

Database Search Ctrl +F 

Refresh View Ctrl +R 

Save Settings Ctrl +S 

Select Global Font Ctrl +G 
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 Message display conventions. 

Figure 32 – Error Dialog Box  

Dialog boxes with error messages appears with this look: 

This message indicates that the item you are trying to reserve is not available (the number of copies 

is 0). 

 

Figure 33 – Question Dialog box  

Message waiting a user decision.   

 Colors schemes 

The Biblioteq uses a color scheme to help users to identify/distinguish the necessary fields 

to fill from the optional ones. The pink fields must all be filled in, while the white ones are optional. 

 Accommodations for visually impaired users. 

BiblioteQ allows to change the letter type and, even more important, the size. On the 

[Options] Menu you can Select Global Font (Ctrl +G) and increase the letter size. All the lettering of 

the BiblioteQ database will automatically change: 

    

Figure 34 – Steps to change the lettering 

4.3 Software interfaces 

The application is supported on numerous platforms, including FreeBSD, Linux, OS X, Solaris, and 

Windows. Installers are available for OS X and Windows.  

BiblioteQ allows as well exporting of views to CSV files. 
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4.4 Communication protocols and interfaces 

For some categories, BiblioteQ provides a mechanism for querying the Library of Congress, or any 

other Z39.50-capable system, via the standard Z39.50 protocol; thus simplifying the data-entry 

process. As for database connectivity, BiblioteQ supports both PostgreSQL and SQLite database 

engines.  The Z39.50 protocol is used for retrieving data for books, journals, and magazines. 

5. Other Nonfunctional Requirements 

5.1 Performance requirements 

 For items with ISBN and ISSN numbers, BiblioteQ offers the ability to query the Library of 

Congress and Columbia University catalogs via the standard Z39.50 protocol, thereby 

allowing for quicker data entry.  

 For books, BiblioteQ also offers cover image retrieval via Amazon.com. 

 Embedded hyperlinks automatically assigned by the program for localized searches of 

related items 

 

5.2 Safety Requirements 

When you create an administrator account for a person on the Desktop Application, you 

should immediately register that user online, as well. This prevents any future non-administrators 

from inadvertently using an administrator's username and receiving their privileges.  

Is recommended that you register the xbook_admin account online (whether you'll use it or 

not) to prevent it from being used for dishonorable purposes. 

5.3 Software Quality Attributes  

 Biblioteq is a small and light project, an easy to use application designed to help you easily 

manage your library. 

 The application is supported on numerous platforms, including FreeBSD, Linux, OS X, 

Solaris, and Windows. Installers are available for OS X, Unix, and Windows. 

  As for database connectivity, BiblioteQ supports both PostgreSQL and SQLite database 

engines.  

 Biblioteq is developed under BSD License free version 6.64 or later.  

http://en.wikipedia.org/wiki/Z39.50

